
คูม่อืการใชง้านโปรแกรม “🎨 สคีอลมัน ์R” 



ตอ่ไปนีค้อืคูม่อืการใชง้านโปรแกรม “🎨 สคีอลมัน ์R” สำหรับชตี Data (คอลมัน ์R) ทีค่ณุตดิตัง้ไวค้รับ 

 

คูม่อืการใชง้าน “🎨 สคีอลมัน ์R” 

1) โปรแกรมทำอะไรไดบ้า้ง 

●​ ตัง้ สไีลร่ะดบั ใหค้อลมัน ์R ตามเกณฑต์วัเลข: 21–30, 31–40, 41–50, 51–80, ≥81​
 

●​ เลอืก โทนส ีได:้ 💜มว่ง / 💙ฟ้า / 💚เขยีว / ❤️แดง / 💛เหลอืง / 🧡สม้​
 

●​ เลอืกโหมดสไีด ้2 แบบ​
 

○​ ชว่งคงที ่(Fixed ranges): ระบายสตีามชว่งตวัเลขตายตวั​
 

○​ Color Scale: ไลส่อีอ่น→เขม้แบบเนยีนตามคา่ (Min=21 / Mid=51 / Max=81)​
 

●​ มเีมนู สุม่โทนส ีทัง้แบบชว่งคงทีแ่ละแบบ Color Scale​
 

●​ มเีมนู ลา้งกฎ:​
 

○​ ลา้งเฉพาะกฎทีท่บัซอ้นคอลมัน ์R​
 

○​ ลา้งเฉพาะกฎทีส่ครปิตน์ีส้รา้ง​
 

○​ ลา้งกฎทัง้ชตี Data​
 

 

2) ข ัน้ตอนตดิต ัง้ (คร ัง้แรก) 
1.​ เปิด Google Sheet ทีต่อ้งการ (ตอ้งมชีตีชือ่ Data)​

 
2.​ ไปที ่Extensions → Apps Script​

 
3.​ วางโคด้ code.gs ทีผ่มใหล้งไป (ทบัของเดมิได)้ → Save​

 
4.​ ครัง้แรกใหก้ด Run ฟังกช์นัใดฟังกช์นัหนึง่เพือ่อนุญาตสทิธิ ์(Authorize) ตามทีร่ะบบแจง้​

 
5.​ กลบัไปหนา้ Spreadsheet แลว้ รเีฟรชหนา้เว็บ​

 



6.​ จะเห็นเมนูใหมบ่นแถบเมนูชือ่ “🎨 สคีอลมัน ์R”​
 

ถา้เมนูไมข่ึน้ ใหล้องรเีฟรชอกีครัง้ หรอืรันฟังกช์นั onOpen() ใน Apps Script หนึง่ครัง้ 

 

3) ภาพรวมเมนแูละคำส ัง่ 
เมนู: 🎨 สคีอลมัน ์R 

●​ โทนส ี(แตล่ะโทนม ี2 คำสัง่)​
 

○​ ชว่งคงที:่ ตัง้ 5 ชว่งคงที ่21–30, 31–40, 41–50, 51–80, ≥81​
 

○​ Color Scale: ไลส่อีตัโนมตั ิMin=21, Mid=51, Max=81​
 

●​ 🎲 สุม่โทนส​ี
 

○​ สุม่โทน (ชว่งคงที)่​
 

○​ สุม่โทน (Color Scale)​
 

●​ 🧹 ลา้งกฎ​
 

○​ ลา้งกฎทีท่บัซอ้นคอลมัน ์R​
 

○​ ลา้งเฉพาะกฎทีส่ครปิตน์ีต้ัง้ในคอลมัน ์R​
 

○​ ลา้งกฎทัง้ชตี Data​
 

 

4) วธิใีชง้านหลกั (Quick Start) 

A) ต ัง้สโีทนมว่งแบบชว่งคงที ่

1.​ ไปทีเ่มนู 🎨 สคีอลมัน ์R → 💜 มว่ง → ชว่งคงที​่
 

2.​ โปรแกรมจะลบกฎทีท่บัซอ้นคอลมัน ์R และเพิม่กฎใหมใ่หท้นัท​ี
 

B) ต ัง้สโีทนมว่งแบบ Color Scale 

1.​ ไปที ่🎨 สคีอลมัน ์R → 💜 มว่ง → Color Scale (21 → 81)​
 



2.​ โปรแกรมจะตัง้ไลส่อีตัโนมตัจิาก 21 (ออ่น) ถงึ 81 (เขม้)​
 

C) สุม่โทนสแีบบ Color Scale 

1.​ ไปที ่🎨 สคีอลมัน ์R → 🎲 สุม่โทนส ี→ สุม่โทน (Color Scale)​
 

2.​ ระบบจะสุม่เลอืกโทนและตัง้ไลส่ใีหท้นัท​ี
 

D) ลา้งกฎคอลมัน ์R 

ไปที ่🎨 สคีอลมัน ์R → 🧹 ลา้งกฎ แลว้เลอืกหนึง่ในตวัเลอืก: 

●​ ลา้งกฎทีท่บัซอ้นคอลมัน ์R (แนะนำ)​
 

●​ ลา้งเฉพาะกฎทีส่ครปิตน์ีต้ ัง้ในคอลมัน ์R​
 

●​ ลา้งกฎท ัง้ชตี Data (แรงสดุ รเีซต็ทัง้หมด)​
 

 

5) หลกัการทำงานของสองโหมด 
●​ ชว่งคงที ่(Fixed ranges)​

 เหมาะเมือ่คณุตอ้งการ “สตีามเกณฑค์ะแนนทีก่ำหนดไวช้ดัเจน”​
 

○​ 21–30 = เฉดสอีอ่นสดุ​
 

○​ 31–40​
 

○​ 41–50​
 

○​ 51–80​
 

○​ ≥81 = เฉดสเีขม้สดุ​
 

●​ Color Scale​
 เหมาะเมือ่คณุตอ้งการไลส่ตีอ่เนือ่งตามคา่แบบเนยีน ๆ โดยตัง้ Min=21, Mid=51, Max=81​
 

ทัง้สองโหมดจะปรับสเีฉพาะ คอลมัน ์R ของชตี Data เทา่นัน้ 

 

6) เคล็ดลบัการใชง้าน 



●​ ถา้ แถว R1 เป็นหวัตาราง ควรใหข้อ้มลูเริม่ที ่R2 เป็นตน้ไป (ไมจ่ำเป็นตอ้งแกโ้คด้ ระบบใชส้ตูร
ล็อกคอลมัน ์$R1 ซึง่เลือ่นตามแถวอตัโนมตัไิด)้​
 

●​ ถา้ขอ้มลูบางเซลลเ์ป็น ขอ้ความ (text) สจีะไมท่ำงาน ใหแ้ปลงเป็นตวัเลขจรงิ (เชน่ เอา , ออก 
หรอืใช ้VALUE() / Paste special → Values only)​
 

●​ ถา้ม ีกฎเดมิหลายชุด แนะนำใช ้“ลา้งกฎทีท่บัซอ้นคอลมัน ์R” กอ่นตัง้กฎใหมท่กุครัง้ เพือ่
ลดการทบัซอ้น​
 

●​ ถา้คอลมัน ์R ถกู ป้องกนั (Protected range) หรอืชตีถกูล็อก ใหป้ลดล็อกกอ่นตัง้กฎ​
 

 

7) การปรบัแตง่ทีพ่บบอ่ย 

7.1 เปลีย่นชว่งทำงาน (เฉพาะบางแถว) 

●​ แทน R:R เป็นชว่งทีต่อ้งการ เชน่ R2:R500​
 

○​ แกใ้นบรรทดัทีเ่รยีกใชฟั้งกช์นัตัง้ส ี(ในฟังกช์นั applyFixedRules / 
applyColorScale ทีเ่รยีกดว้ย 'R:R')​
 

7.2 เปลีย่นชือ่ชตี 

●​ แก ้'Data' เป็นชือ่ชตีของคณุ ในฟังกช์นัเรยีกใช ้(เชน่ applyFixedRules('ช่ือชีต
','R:R',...))​
 

7.3 เปลีย่นเกณฑต์วัเลข (21, 31, 41, 51, 81) 
โหมด “ชว่งคงที”่: แกส้ตูรใน applyFixedRules() ทีก่ำหนดเป็น​
​
 =AND(ISNUMBER($R1), $R1>=คา่ต่ำ, $R1<คา่สงู) 

●​  
●​ โหมด Color Scale: แกค้า่ Min/Mid/Max ใน applyColorScale() (คา่ '21' / '51' / '81')​

 

7.4 เพิม่โทนสใีหม ่
เพิม่รายการในคงที ่PALETTES เชน่​
​
 '💗 ชมพ'ู: ['#FCE4EC','#F8BBD0','#F06292','#E91E63','#880E4F'] 

●​  



●​ แลว้สรา้งฟังกช์นัเรยีกใชค้ลา้ย ๆ โทนอืน่ ๆ​
 

 

8) ปญัหาทีพ่บบอ่ย & วธิแีก ้
Q: กด “ลา้งกฎ” แลว้บางกฎยงัอยู?่​
 A: ใชต้วัเลอืก “ลา้งกฎทีท่บัซอ้นคอลมัน ์R” ซึง่จะลบทกุกฎทีช่ว่ง แตะ คอลมัน ์R (แมก้ฎนัน้ครอบ
คอลมันอ์ืน่ดว้ย) หากยงัม ีใหใ้ช ้“ลา้งกฎท ัง้ชตี Data” (จะลา้งหมดทัง้ชตี) 

Q: ทำไมสไีมข่ ึน้? 

●​ คา่ใน R เป็น ขอ้ความ ไมใ่ชต่วัเลข → แปลงเป็นตวัเลข​
 

●​ คา่ต่ำกวา่ 21 (นอกชว่ง) ในโหมดชว่งคงที ่→ จะไมต่ดิส​ี
 

●​ ม ีกฎอืน่ ทบัซอ้นและอยูล่ำดบับนกวา่ → ลา้งกฎกอ่น หรอืจัดลำดบัใหม​่
 

Q: เมนไูมแ่สดงหลงัวางโคด้? 

●​ บนัทกึโคด้แลว้ รเีฟรช​
 

●​ รัน onOpen() ใน Apps Script หนึง่ครัง้​
 

●​ ตรวจสทิธิ ์(Authorize) ใหค้รบ​
 

Q: ใชก้บัหลายชตีไดไ้หม? 

●​ ได ้โดยคดัลอกโคด้ไปใช ้และเปลีย่นชือ่ชตี/ชว่งตามตอ้งการ หรอืเพิม่เมนูยอ่ยใหเ้ลอืกชตี​
 

 

9) โทนสทีีใ่ช ้(อา้งองิ) 

●​ 💜 มว่ง: #E1BEE7, #CE93D8, #BA68C8, #8E24AA, #6A1B9A​
 

●​ 💙 ฟ้า: #BBDEFB, #90CAF9, #42A5F5, #1E88E5, #0D47A1​
 

●​ 💚 เขยีว: #C8E6C9, #A5D6A7, #66BB6A, #388E3C, #1B5E20​
 

●​ ❤️ แดง: #FFCDD2, #EF9A9A, #E57373, #E53935, #B71C1C​
 



●​ 💛 เหลอืง: #FFF9C4, #FFF59D, #FFF176, #FBC02D, #F57F17​
 

●​ 🧡 สม้: #FFE0B2, #FFCC80, #FFB74D, #FB8C00, #E65100​
 

 

10) ตวัอยา่งการใชง้านดว่น (แนะนำ) 
1.​ ตอ้งการโทนมว่งแบบชว่งคงที ่→ 🎨 สคีอลมัน ์R → 💜 มว่ง → ชว่งคงที​่

 
2.​ เปลีย่นใจอยากลองสเีขยีวแบบ Color Scale → 💚 เขยีว → Color Scale​

 
3.​ อยากรเีซต็คอลมัน ์R → 🧹 ลา้งกฎ → ลา้งกฎทีท่บัซอ้นคอลมัน ์R​

 
4.​ ลองสุม่โทนสวย ๆ → 🎲 สุม่โทนส ี→ สุม่โทน (Color Scale)​

 

 

หากตอ้งการ “จำโทนลา่สดุ” เพือ่เรยีกใชซ้้ำจากเมนูดว่น หรอือยากจำกดัชว่งเฉพาะ R2:R500 เป็นคา่
เริม่ตน้ บอกผมไดเ้ลย เดีย๋วผมปรับโคด้ใหพ้รอ้มใชใ้หค้รับ 👍 

 



formatColor.gs 



/*********************** 
 *  🎨 R Column Styler 
 *  Sheet: 'Data', Column: R 
 *  Ranges: 21–30, 31–40, 41–50, 51–80, ≥81 
 ***********************/ 
 
function onOpen() { 
  const ui = SpreadsheetApp.getUi(); 
  ui.createMenu('🎨 สคีอลมัน ์R') 
    .addSubMenu( 
      ui.createMenu('💜 มว่ง') 
        .addItem('ชว่งคงที ่(21–30,31–40,41–50,51–80,≥81)', 'setupRangingPurple') 
        .addItem('Color Scale (21→81)', 'setupColorScalePurple') 
    ) 
    .addSubMenu( 
      ui.createMenu('💙 ฟ้า') 
        .addItem('ชว่งคงที'่, 'setupRangingBlue') 
        .addItem('Color Scale', 'setupColorScaleBlue') 
    ) 
    .addSubMenu( 
      ui.createMenu('💚 เขยีว') 
        .addItem('ชว่งคงที'่, 'setupRangingGreen') 
        .addItem('Color Scale', 'setupColorScaleGreen') 
    ) 
    .addSubMenu( 
      ui.createMenu('❤️ แดง') 
        .addItem('ชว่งคงที'่, 'setupRangingRed') 
        .addItem('Color Scale', 'setupColorScaleRed') 
    ) 
    .addSubMenu( 
      ui.createMenu('💛 เหลอืง') 
        .addItem('ชว่งคงที'่, 'setupRangingYellow') 
        .addItem('Color Scale', 'setupColorScaleYellow') 
    ) 
    .addSubMenu( 
      ui.createMenu('🧡 สม้') 
        .addItem('ชว่งคงที'่, 'setupRangingOrange') 
        .addItem('Color Scale', 'setupColorScaleOrange') 
    ) 
    .addSubMenu( 
      ui.createMenu('🎲 สุม่โทนส'ี) 
        .addItem('สุม่โทน (ชว่งคงที)่', 'setupRangingRandom') 
        .addItem('สุม่โทน (Color Scale)', 'setupColorScaleRandom') 
    ) 
    .addSubMenu( 
      ui.createMenu('🧹 ลา้งกฎ') 
        .addItem('ลา้งกฎทีท่บัซอ้นคอลมัน ์R', 'clearRulesR') 
        .addItem('ลา้งเฉพาะกฎทีส่ครปิตน์ีต้ัง้ในคอลมัน ์R', 'clearOnlyOurRulesInR') 



        .addItem('ลา้งกฎทัง้ชตี Data', 'clearAllRulesInSheet') 
    ) 
    .addToUi(); 
} 
 
/* ========= พาเลตส ี(Material-ish) ========= */ 
const PALETTES = { 
  '💜 มว่ง' : ['#E1BEE7','#CE93D8','#BA68C8','#8E24AA','#6A1B9A'], 
  '💙 ฟ้า'  : ['#BBDEFB','#90CAF9','#42A5F5','#1E88E5','#0D47A1'], 
  '💚 เขยีว': ['#C8E6C9','#A5D6A7','#66BB6A','#388E3C','#1B5E20'], 
  '❤️ แดง'  : ['#FFCDD2','#EF9A9A','#E57373','#E53935','#B71C1C'], 
  '💛 เหลอืง': ['#FFF9C4','#FFF59D','#FFF176','#FBC02D','#F57F17'], 
  '🧡 สม้'  : ['#FFE0B2','#FFCC80','#FFB74D','#FB8C00','#E65100'] 
}; 
 
/* ========= ฟังกช์นักลาง: ตัง้ชว่งคงที ่/ Color scale ========= */ 
function applyFixedRules(sheetName, rangeA1, colors, label) { 
  const sh = SpreadsheetApp.getActive().getSheetByName(sheetName); 
  if (!sh) throw new Error('ไมพ่บชตีชือ่ ' + sheetName); 
  const range = sh.getRange(rangeA1); 
 
  // ลา้งกฎที ่"ทบัซอ้น" กบัคอลมันเ์ป้าหมายกอ่น 
  clearConditionalInRange_(sh, range); 
 
  const rules = sh.getConditionalFormatRules(); 
  const makeRule = (formula, bg) => 
    SpreadsheetApp.newConditionalFormatRule() 
      .whenFormulaSatisfied(formula) 
      .setBackground(bg) 
      .setFontColor('#000000') 
      .setRanges([range]) 
      .build(); 
 
  // ชว่งคงที ่21–30, 31–40, 41–50, 51–80, ≥81 (ล็อกคอลมัน ์R แตใ่หเ้ลือ่นแถวได)้ 
  const r1 = makeRule('=AND(ISNUMBER($R1), $R1>=21, $R1<31)', colors[0]); 
  const r2 = makeRule('=AND(ISNUMBER($R1), $R1>=31, $R1<41)', colors[1]); 
  const r3 = makeRule('=AND(ISNUMBER($R1), $R1>=41, $R1<51)', colors[2]); 
  const r4 = makeRule('=AND(ISNUMBER($R1), $R1>=51, $R1<81)', colors[3]); 
  const r5 = makeRule('=AND(ISNUMBER($R1), $R1>=81)',            colors[4]); 
 
  rules.push(r1, r2, r3, r4, r5); 
  sh.setConditionalFormatRules(rules); 
  SpreadsheetApp.getActive().toast('ตัง้คา่สำเร็จ: ' + label + ' (ชว่งคงที)่', '🎨 สคีอลมัน ์R', 4); 
} 
 
function applyColorScale(sheetName, rangeA1, minColor, midColor, maxColor, label) { 
  const sh = SpreadsheetApp.getActive().getSheetByName(sheetName); 
  if (!sh) throw new Error('ไมพ่บชตีชือ่ ' + sheetName); 



  const range = sh.getRange(rangeA1); 
 
  clearConditionalInRange_(sh, range); 
 
  const rules = sh.getConditionalFormatRules(); 
  const rule = SpreadsheetApp.newConditionalFormatRule() 
    .setGradientMinpointWithValue(SpreadsheetApp.InterpolationType.NUMBER, '21', 
minColor) 
    .setGradientMidpointWithValue(SpreadsheetApp.InterpolationType.NUMBER, '51', 
midColor) 
    .setGradientMaxpointWithValue(SpreadsheetApp.InterpolationType.NUMBER, '81', 
maxColor) 
    .setRanges([range]) 
    .build(); 
 
  rules.push(rule); 
  sh.setConditionalFormatRules(rules); 
  SpreadsheetApp.getActive().toast('ตัง้คา่สำเร็จ: ' + label + ' (Color Scale)', '🎨 สคีอลมัน ์R', 
4); 
} 
 
/* ========= ยทูลิติี:้ ตรวจทบัซอ้นและลา้งกฎ ========= */ 
// ตรวจวา่ชว่งสองชว่งทบัซอ้นกนัหรอืไม ่
function rangesIntersect_(aRange, bRange) { 
  const aRow1 = aRange.getRow(), aRow2 = aRow1 + aRange.getNumRows() - 1; 
  const aCol1 = aRange.getColumn(), aCol2 = aCol1 + aRange.getNumColumns() - 1; 
  const bRow1 = bRange.getRow(), bRow2 = bRow1 + bRange.getNumRows() - 1; 
  const bCol1 = bRange.getColumn(), bCol2 = bCol1 + bRange.getNumColumns() - 1; 
  const rowsOverlap = !(aRow2 < bRow1 || bRow2 < aRow1); 
  const colsOverlap = !(aCol2 < bCol1 || bCol2 < aCol1); 
  return rowsOverlap && colsOverlap; 
} 
 
// ลา้งกฎทกุอนัที ่“ทบัซอ้น” กบัชว่งทีใ่หม้า (ใชไ้ดจ้รงิกบักรณี R:R) 
function clearConditionalInRange_(sheet, targetRange) { 
  const oldRules = sheet.getConditionalFormatRules(); 
  const keep = []; 
  for (const rule of oldRules) { 
    const touches = rule.getRanges().some(rg => rangesIntersect_(rg, targetRange)); 
    if (!touches) keep.push(rule); 
  } 
  sheet.setConditionalFormatRules(keep); 
  return oldRules.length - keep.length; 
} 
 
// ลา้งกฎทัง้ชตี 
function clearAllRulesInSheet() { 
  const sh = SpreadsheetApp.getActive().getSheetByName('Data'); 



  if (!sh) throw new Error('ไมพ่บชตีชือ่ Data'); 
  sh.setConditionalFormatRules([]); 
  SpreadsheetApp.getActive().toast('ลา้งกฎ Conditional Formatting ทัง้ชตีแลว้', '🧹 เคลยีรก์ฎ', 
4); 
} 
 
// ลา้งเฉพาะ “กฎทีส่ครปิตน์ีต้ัง้” ในคอลมัน ์R (จับจากสตูร/คา่ส/ีชว่ง) 
function clearOnlyOurRulesInR() { 
  const sh = SpreadsheetApp.getActive().getSheetByName('Data'); 
  if (!sh) throw new Error('ไมพ่บชตีชือ่ Data'); 
  const target = sh.getRange('R:R'); 
  const oldRules = sh.getConditionalFormatRules(); 
  const OUR_FORMULAS = new Set([ 
    '=AND(ISNUMBER($R1), $R1>=21, $R1<31)', 
    '=AND(ISNUMBER($R1), $R1>=31, $R1<41)', 
    '=AND(ISNUMBER($R1), $R1>=41, $R1<51)', 
    '=AND(ISNUMBER($R1), $R1>=51, $R1<81)', 
    '=AND(ISNUMBER($R1), $R1>=81)' 
  ]); 
 
  const keep = []; 
  let removed = 0; 
 
  for (const rule of oldRules) { 
    const touchesR = rule.getRanges().some(rg => rangesIntersect_(rg, target)); 
    let isOurs = false; 
 
    // จับกฎแบบสตูรคงที ่
    const cond = rule.getBooleanCondition && rule.getBooleanCondition(); 
    if (cond) { 
      const type = cond.getCriteriaType && cond.getCriteriaType(); 
      const args = cond.getCriteriaValues && cond.getCriteriaValues(); 
      // whenFormulaSatisfied เกบ็สตูรไวใ้น args[0] 
      if (type === SpreadsheetApp.BooleanCriteria.CUSTOM_FORMULA && args && 
OUR_FORMULAS.has(String(args[0]).trim())) { 
        isOurs = true; 
      } 
    } 
 
    // จับกฎแบบไลส่ทีีม่คีา่คงที ่21 / 51 / 81 (ตามทีส่ครปิตต์ัง้) 
    const grad = rule.getGradientCondition && rule.getGradientCondition(); 
    if (!isOurs && grad) { 
      const min = grad.getMinpoint() || {}; 
      const mid = grad.getMidpoint() || {}; 
      const max = grad.getMaxpoint() || {}; 
      // เงือ่นไขของเรา: NUMBER=21, NUMBER=51, NUMBER=81 
      const looksLikeOurs = 



        min.type === SpreadsheetApp.InterpolationType.NUMBER && String(min.value) === 
'21' && 
        mid.type === SpreadsheetApp.InterpolationType.NUMBER && String(mid.value) === 
'51' && 
        max.type === SpreadsheetApp.InterpolationType.NUMBER && String(max.value) === 
'81'; 
      if (looksLikeOurs) isOurs = true; 
    } 
 
    if (touchesR && isOurs) { 
      removed++; 
      continue; // drop 
    } 
    keep.push(rule); 
  } 
 
  sh.setConditionalFormatRules(keep); 
  SpreadsheetApp.getActive().toast(`ลบกฎของสครปิตน์ีใ้นคอลมัน ์R แลว้ ${removed} รายการ`, 
'🧹 เคลยีรก์ฎ', 4); 
} 
 
/* ========= เมนู: ลา้งกฎทีท่บัซอ้นคอลมัน ์R ========= */ 
function clearRulesR() { 
  const sh = SpreadsheetApp.getActive().getSheetByName('Data'); 
  if (!sh) throw new Error('ไมพ่บชตีชือ่ Data'); 
  const target = sh.getRange('R:R'); 
  const removed = clearConditionalInRange_(sh, target); 
  SpreadsheetApp.getActive().toast(`ลบกฎทีท่บัซอ้นคอลมัน ์R แลว้ ${removed} รายการ`, '🧹 
เคลยีรก์ฎ', 4); 
} 
 
/* ========= ตวัเรยีกใชง้านสำหรับแตล่ะโทน ========= */ 
function setupRangingPurple(){ applyFixedRules('Data','R:R', PALETTES['💜 มว่ง'], '💜 มว่ง'); 
} 
function setupColorScalePurple(){ applyColorScale('Data','R:R', PALETTES['💜 มว่ง'][0], 
PALETTES['💜 มว่ง'][2], PALETTES['💜 มว่ง'][4], '💜 มว่ง'); } 
 
function setupRangingBlue(){ applyFixedRules('Data','R:R', PALETTES['💙 ฟ้า'], '💙 ฟ้า'); } 
function setupColorScaleBlue(){ applyColorScale('Data','R:R', PALETTES['💙 ฟ้า'][0], 
PALETTES['💙 ฟ้า'][2], PALETTES['💙 ฟ้า'][4], '💙 ฟ้า'); } 
 
function setupRangingGreen(){ applyFixedRules('Data','R:R', PALETTES['💚 เขยีว'], '💚 เขยีว
'); } 
function setupColorScaleGreen(){ applyColorScale('Data','R:R', PALETTES['💚 เขยีว'][0], 
PALETTES['💚 เขยีว'][2], PALETTES['💚 เขยีว'][4], '💚 เขยีว'); } 
 
function setupRangingRed(){ applyFixedRules('Data','R:R', PALETTES['❤️ แดง'], '❤️ แดง'); } 



function setupColorScaleRed(){ applyColorScale('Data','R:R', PALETTES['❤️ แดง'][0], 
PALETTES['❤️ แดง'][2], PALETTES['❤️ แดง'][4], '❤️ แดง'); } 
 
function setupRangingYellow(){ applyFixedRules('Data','R:R', PALETTES['💛 เหลอืง'], '💛 
เหลอืง'); } 
function setupColorScaleYellow(){ applyColorScale('Data','R:R', PALETTES['💛 เหลอืง'][0], 
PALETTES['💛 เหลอืง'][2], PALETTES['💛 เหลอืง'][4], '💛 เหลอืง'); } 
 
function setupRangingOrange(){ applyFixedRules('Data','R:R', PALETTES['🧡 สม้'], '🧡 สม้'); 
} 
function setupColorScaleOrange(){ applyColorScale('Data','R:R', PALETTES['🧡 สม้'][0], 
PALETTES['🧡 สม้'][2], PALETTES['🧡 สม้'][4], '🧡 สม้'); } 
 
/* ========= สุม่โทน ========= */ 
function setupRangingRandom() { 
  const keys = Object.keys(PALETTES); 
  const pick = keys[Math.floor(Math.random() * keys.length)]; 
  applyFixedRules('Data','R:R', PALETTES[pick], pick + ' • Random'); 
} 
function setupColorScaleRandom() { 
  const keys = Object.keys(PALETTES); 
  const pick = keys[Math.floor(Math.random() * keys.length)]; 
  const p = PALETTES[pick]; 
  applyColorScale('Data','R:R', p[0], p[2], p[4], pick + ' • Random'); 
} 
 



แนวคดิ (Concept) 



ไดเ้ลยครับ — นีค่อื “ขัน้ตอนการสรา้งสตูร” + “แนวคดิ” แบบจับมอืทำ สำหรับการไลส่คีอลมัน ์R ในชตี 
Data ตามชว่ง 21–30, 31–40, 41–50, 51–80, ≥81 ดว้ยสมีว่งจากออ่นไปเขม้ 

 

แนวคดิ (Concept) 
1.​ กำหนดชว่งแบบไมซ่อ้นทบั (Non-overlapping)​

 ใชห้ลกั “ปิดทีข่อบลา่ง เปิดทีข่อบบน” คอื >= ค่าต่ำ และ < ค่าสูง ยกเวน้ชว่งสดุทา้ย >=81 
เพือ่กนัชนกนัพอดทีี ่31, 41, 51, 81​
 

○​ 21–30: >=21 และ <31​
 

○​ 31–40: >=31 และ <41​
 

○​ 41–50: >=41 และ <51​
 

○​ 51–80: >=51 และ <81​
 

○​ ≥81: >=81​
 

2.​ ล็อกคอลมัน ์แตใ่หเ้ลือ่นตามแถว​
 ใน Conditional formatting สตูรจะอา้งองิ “แถวแรกของชว่งทีเ่ลอืก” เป็นจดุอา้งองิ​
 

○​ ถา้เลอืกทัง้คอลมัน ์R:R → แถวแรกคอื R1 ใช ้$R1​
 

○​ ถา้เลอืกตัง้แต ่R2:R → แถวแรกคอื R2 ใช ้$R2​
 หลกัคอื ตวัเลขหลงั R ตอ้งตรงกบั “แถวบนสดุของชว่งทีค่ณุเลอืก” เสมอ​
 

3.​ กนัขอ้มลูไมใ่ชต่วัเลข​
 ใช ้ISNUMBER() ครอบ เพือ่ไมใ่หช้อ่งวา่ง/ขอ้ความตดิสผีดิพลาด​
 

4.​ ส:ี ออ่นไปเขม้ (โทนมว่ง Material-ish)​
 

○​ 21–30 → #E1BEE7​
 

○​ 31–40 → #CE93D8​
 

○​ 41–50 → #BA68C8​
 

○​ 51–80 → #8E24AA​
 



○​ ≥81 → #6A1B9A​
 

5.​ สองแนวทาง​
 

○​ Fixed ranges (หลายกฎ): คมุไดเ้ป๊ะตามเกณฑ​์
 

○​ Color scale (กฎเดยีว): ไลส่เีนยีนตามคา่ (ตัง้ Min=21, Mid=51, Max=81)​
 

 

ข ัน้ตอนสรา้ง “สตูร” แบบ Fixed ranges 
(Manual) 

ตวัอยา่งนีส้มมตคิณุเลอืก ท ัง้คอลมัน ์R (R:R) ถา้เลอืก R2:R ใหเ้ปลีย่น $R1 เป็น $R2 

1.​ ไฮไลตช์ว่งทีจ่ะลงส ี→ R:R​
 

2.​ ไปที ่Format → Conditional formatting → Add another rule​
 

3.​ เลอืก Custom formula is แลว้ใสส่ตูรตามชว่งดา้นลา่ง (สรา้ง 5 กฎ)​
 

●​ ชว่ง 21–30 (มว่งออ่น #E1BEE7)​
 

=AND(ISNUMBER($R1), $R1>=21, $R1<31) 

 

●​ ชว่ง 31–40 (มว่งออ่นกลาง #CE93D8)​
 

=AND(ISNUMBER($R1), $R1>=31, $R1<41) 

 

●​ ชว่ง 41–50 (มว่งกลาง #BA68C8)​
 

=AND(ISNUMBER($R1), $R1>=41, $R1<51) 

 

●​ ชว่ง 51–80 (มว่งเขม้ #8E24AA)​
 



=AND(ISNUMBER($R1), $R1>=51, $R1<81) 

 

●​ ชว่ง ≥81 (มว่งเขม้มาก #6A1B9A)​
 

=AND(ISNUMBER($R1), $R1>=81) 

 

4.​ ตัง้ Fill color ของแตล่ะกฎตามโคด้สดีา้นบน​
 

5.​ เรยีงลำดบักฎไมจ่ำเป็นมากนัก (เพราะชว่งไมท่บักนั) แตเ่พือ่ความสบายใจจะเรยีงจากชว่งลา่ง
→บนกไ็ด​้
 

6.​ กด Done​
 

ถา้เลอืกชว่งเริม่ที ่R2:R ใหแ้ทน $R1 ทัง้หมดเป็น $R2 (ย้ำ: ตวัเลขตอ้งเทา่กบัแถวบนสดุ
ของชว่งทีค่ณุเลอืก) 

 

ข ัน้ตอนแบบ Color scale (ไลส่เีนยีนกฎ
เดยีว) 

1.​ ไฮไลตช์ว่ง R:R​
 

2.​ Format → Conditional formatting → แท็บ Color scale​
 

3.​ ตัง้คา่:​
 

○​ Min = Number → 21 → ส ี#E1BEE7​
 

○​ Midpoint = Number → 51 → ส ี#BA68C8​
 

○​ Max = Number → 81 → ส ี#6A1B9A​
 

4.​ กด Done​
 

เหมาะเมือ่คะแนน/คา่กระจายตอ่เนือ่ง ตอ้งการไลเ่ฉดออ่น→เขม้แบบ Smooth 

 



เช็คลสิตท์ดสอบ (Debug Checklist) 
●​ ชอ่งวา่ง/ขอ้ความไมค่วรตดิส ี→ ถา้ตดิ ใหต้รวจวา่ใช ้ISNUMBER() แลว้​

 
●​ คา่ 30 ตอ้งอยูช่ว่งแรก (21–30) เพราะสตูรใช ้<31​

 
●​ คา่ 31 ตอ้งตดิกฎชว่ง 31–40 (เพราะ >=31)​

 
●​ เลอืกชว่ง ถกูจดุเร ิม่ หรอืไม ่(ถา้เลอืก R2:R แตย่งัใช ้$R1 จะอา้งองิแถวผดิ)​

 
●​ ม ีกฎอืน่ทบัอยู ่หรอืเปลา่ → ลองลา้งกฎซ้ำซอ้นกอ่น (ใชเ้มนูทีผ่มใหก้ไ็ด)้​

 

 

ทางเลอืก/ทรคิเพิม่ 
แบบไมเ่ขยีนหลายกฎ (ชว่ยตรวจชว่งในคอลมันช์ว่ย)​
 ใสส่ตูรชว่ยในคอลมันเ์สรมิ (เชน่ S) เพือ่บอกชว่ง แลว้กำหนดสตีามขอ้ความได​้
​
 =IF( NOT(ISNUMBER(R2)), "", 

   IF(R2<21, "ต่ำกวา่ 21", 

   IF(R2<31, "21–30", 

   IF(R2<41, "31–40", 

   IF(R2<51, "41–50", 

   IF(R2<81, "51–80", "81+")))))) 

●​  จากนัน้ตัง้ CF แบบ “Text is exactly” ตอ่ 5 ชว่ง (เขา้ใจงา่ยตอนแกเ้กณฑ)์​
 

●​ ตอ้งครอบท ัง้ชตีอยา่งเร็ว → ใช ้Apps Script ทีผ่มใหไ้ว ้จะเซต็ทกุกฎใหค้อลมัน ์R แบบคลิ
กครัง้เดยีว​
 

 

ถา้ตอ้งการสรปุ ไฟลส์ ัน้ ๆ (PDF/ภาพ) แผน่เดยีวทีม่ ี“สตูรทกุชว่ง + ขัน้ตอน + สทีีใ่ช”้ บอกไดเ้ลย 
เดีย๋วผมแพ็กใหพ้รอ้มใชง้านครับ 💜 
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